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Chapter 1 : Using Paint and how to edit the Text box. - Microsoft Community

Do one of the following to select a type layer: Select the Move tool and double-click the type layer on the canvas. Select
the Horizontal Type tool or the Vertical Type tool. Select the type layer in the Layers panel, or click in the text flow to
automatically select a type layer. Position the.

Add text to a shape Select the shape. When a shape is selected and you start typing, Visio adds the text to the
selected shape. To format the text, you can do either of the following: On the Home tab, in the Font group, set
the font characteristics. On the Home tab, in the Paragraph group, set the alignment and other characteristics.
Click a blank area on the page or press ESC to finish. Add text to the page You can also add text directly to
the page, independent of any shape or object in the drawing. On the Home tab, in the Tools group, click Text.
Click anywhere on the page to create a text box, or click and drag to make the text box the size that you want.
Edit text Double-click the text that you want to edit. If you are not already zoomed in to the shape, Visio
zooms in while you type. When you finish typing, click a blank area on the page or press ESC. Visio zooms
back out. To stop Visio from zooming in on your text: Click the File tab, and then click Options. Click the
Advanced tab. Under Editing options, in the Automatically zoom text when editing under box, enter 0 zero for
the point size. Click the shape to select its text block. If the text is in a group, click to select the group, and
then click to select the text in the shape. Drag the text to move the text block. On the Home tab, in the Tools
group, click the Pointer Tool. After you switch back to the Pointer Tool , the text keeps the same position
relative to the shape. If you use the Pointer Tool to drag the text, the shape will also move, even if the text is
no longer on the shape. To move the text independently of the shape, use the Text Block tool. Click the text
and drag to move it, or drag the rotation handle to rotate the text. When the pointer is over a rotation handle, it
changes to an arrow that forms a circle.
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Chapter 2 : Add, edit, move, or rotate text in Visio - Visio

Select the "Text" tool and click to place a text box. As long as the text box is open, you're free to edit the text. If you're
wondering how to change the color of text in paint, in addition to typing or deleting text, use the settings on the menu bar
to edit the text's formatting, such as font, size and color.

Studios often have to edit PDF documents in order to alter a document created by someone else, or to make a
last minute change without having to return to the source files. This page explains how to make more complex
changes to text and objects using Adobe Creative Suite. The best way to edit a PDF file without actually
recreating it from the source files is by using a combination of Acrobat, Illustrator and Photoshop, depending
on what you need to do. If you only have Adobe Acrobat your options will be limited, but you can still make
simple text and layout changes. As explained in the previous article , below is an example of a simple business
card created and opened in InDesign. All the elements on the page have been selected to give you an idea of
how it is constructed. The logo top left is an Illustrator EPS file with the text converted to outlines. The red
and yellow background boxes and white lines have been created and placed in InDesign. In short, this is a
fairly typical, simple layout. The rest of this page will focus on how to edit PDF files in Photoshop and with
the help of the remainder of the Creative Suite. Acrobat accesses Illustrator and Photoshop and uses them as
super-advanced plug-ins. When you edit an element within a PDF file, Acrobat determines which program
will be best to use as the editor, and it calls it up. Otherwise, the best thing to do is to edit the elements using
Illustrator, accessed from Acrobat 9 or earlier. To do this, open your PDF file. Without selecting any
individual item, right-click anywhere on the page or on the paste board. A dropdown menu will appear. Before
making any changes, take a look at how everything is laid out. The first thing to note is that the text is not
conveniently arranged in text box blocks. This means that the best way to replace the text is to delete the old
and add the new in a wrapping text box. This is just to retain the style. Now type or paste using plain text the
revised address over the top. Use the Direct Selection Tool to delete the old text. Position the new text box
appropriately: Obviously, whilst in Illustrator you can edit any other elements in the same session if you need
to. Please note, however, that if you want to make further edits to the text this will no longer be possible if
they have been converted to paths in this way. Make sure you make a copy of the original PDF file before
altering it. A warning will appear about flattening images: And then the image will open in Photoshop: The
changes are adopted by the PDF file in Acrobat, which you can now save and close. These are the most
common and useful methods of editing a PDF file, other than actually recreating the document from scratch.
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Chapter 3 : How to edit scanned PDF, edit PDF scanned, scan to PDF - Adobe Acrobat

The Edit Text & Images tool lets you replace, edit, or add text to a PDF. You can correct typos, change fonts and
typeface size, adjust alignment, add superscripts or subscripts, and resize text or paragraphs.

This will enable making edits to the actual text, such as adding a word or fixing the spelling of something.
You can also change the font and color. Each version of SketchBook has slightly different tools for editing
text. Some are more robust than others. Click-drag the opacity slider to change the transparency of a text layer.
Font size determines how much you can scale a font. A font size of 12 cannot be scaled up as much as one set
to  A font of 12 cannot be scaled down as much as one set to 5. See only the fonts you want. Create custom
font collections. Use default sets to load only fun fonts or ones with fixed width. Load only your favorite fonts
or those recently used. To set text color, click. Changing the transparency of text In the Layer Editor, tap-drag
the slider seen below to increase or decrease layer opacity. Drag up to decrease opacity, making the layer
content solid. Drag down to increase opacity, making the layer content more transparent. Use the puck to
select a different mode. When rotating or scaling the text, SketchBook uses the center of the text as the pivot
point. When scaling text, font size is changed, resulting in no visual quality change. Keep in mind, changes to
the size will affect the quality of the image, since you are scaling a rasterized image. This is why we
recommend you do it once and do it right, if working in the free version. Exclusive to the subscription version
Since your text it pixels and not rasterized, you can make changes to it without affecting the quality of the
image. However, you can change text into paint, using , so you can manipulate it like a paint layer.
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Chapter 4 : Edit text in Photoshop

Paint is a very simple program and does not support re-selecting a text box to edit the contents. "mikecvista" wrote in
message news:*** Email address is removed for privacy ***.

Reflow paragraphs and correct typosâ€” without returning to your original source document. This document
provides instructions for Acrobat DC and Acrobat  You can correct typos, change fonts and typeface size,
adjust alignment, add superscripts or subscripts, and resize text or paragraphs. You edit a PDF one page at a
time. For more extensive editing or to make global formatting changes across the entire document, edit the
original document. Then edit, and re-create the PDF. Each text box is independent, and inserting text in one
text block does not push down an adjacent text box or reflow to the next page. Outlines identify the text and
images you can edit. Select the text you want to edit. Edit the text by doing one of the following: Type new
text to replace the selected text, or press Delete to remove it. You can create new list items, convert an existing
paragraph to a list item, convert an existing list item to a paragraph, and convert from one list type to another.
Select a font, font size, or other formatting options under Format in the right pane. You can also use the
advanced format options, such as line spacing, character spacing, horizontal scaling, stroke width, and color.
Formatting options in the right pane Note: For legal reasons, you must have purchased a font and have it
installed on your system to revise text using that font. You can edit text only if the font used for that text is
installed on your system. Click outside the selection to deselect it and start over. Add or edit a numbered or
bulleted list You can add items to a numbered or bulleted list, create new list items, convert an existing
paragraph to a list item, convert an existing list item to a paragraph, and convert from one list type to another.
Acrobat detects paragraphs and lists separately. Therefore, both paragraph and list may appear in the same
bounding box while editing. After you save or save as the changed file and reopen it, the paragraph and list
items are displayed in separate bounding boxes. To add or remove items from a numbered or bulleted list: You
can add or remove items to the list at all nested levels using the same familiar controls that you use in MS
Office. For example, press Enter at the end of a list item to insert a new row. Press Backspace to remove the
new row and position the cursor back to the end of the previous list item. To create a numbered or bulleted
list: Place the cursor in the document at the location where you want to add a new list. To convert an existing
paragraph to a list item: To convert an existing list item to a paragraph: Select all items in the list. The
appropriate list type is highlighted under Format in the right pane. Click the highlighted list type. To convert
from one list type to another: Place the cursor in the list item or select all items in the list. Choose the
appropriate list type bulleted or numbered under Format in the right pane. You can also use Keyboard to add a
list item. Drag to define the width of the text block you want to add. For vertical text, right-click the text box,
and choose Make Text Direction Vertical. The Add text tool intelligently detects the following text properties
of text close to the point of click: Font name, size, and color Character, paragraph, and line spacing Horizontal
scaling These text properties are automatically applied to the text that you add at the point of click. You can
change the text properties using the options under Format in the right pane. To resize the text box, drag a
selection handle. To move the text box, place the pointer over the line of the bounding box avoid the selection
handles. When the cursor changes to Move pointer , drag the box to the new location. To maintain alignment
with the other list items, press Shift as you drag. Move, rotate, or resize a text box You can move or rotate text
boxes on a page. Edits are confined to the page. You cannot drag a text block to another page, or move or
rotate individual characters or words within a text box. However, you can copy text boxes and paste them on
another page. Resizing a text box causes the text to reflow within the new text box boundaries. It does not
change the size of the text. To change the font size, see Edit or format text in a PDF. As with other text edits,
resizing is limited to the current page. Text does not flow to the next page. Click the text box you want to
move, rotate, or resize. A bounding box with selection handles surrounds the text box you clicked. Do any of
the following: Move Place the pointer over the line of the bounding box avoid the selection handles. When the
cursor changes to Move pointer , drag the box to the desired location. Hold down the Shift key as you drag to
constrain the movement vertically or horizontally. Rotate Place the pointer just outside a selection handle.
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When the cursor changes to the Rotation pointer , drag in the direction you want it to rotate. Resize Place the
pointer over a selection handle. When the cursor changes to the Resize pointer , drag the handle to resize the
text block. Add, edit, or move text on noninteractive forms or when signing Organizations sometimes provide
PDF versions of their paper forms without interactive form fields called "flat forms". Use the Add Text tool on
the Comment toolbar to fill in noninteractive forms or to add text to documents you need to sign. Text added
with this tool is actually a comment and does not change the original PDF. Click where you want to add text.
In the Text Properties toolbar, select the color, font, and font size for the text you want to add. Text Properties
toolbar Note: Press Enter to add a second line. Edit text in a noninteractive flat form PDF To change the text
properties, select the text you want to edit. Use any of the following tools in the Text Properties toolbar: Use
the various options in the toolbar to change text properties Note: Choose a font size from the pop-up menu. In
the comment list, click the comment containing the text you want to move or resize. When the bounding box
appears, drag the text block or one of its corners.
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Chapter 5 : How to Add and Edit Text in Adobe Photoshop

This article is going to teach you how to edit text in Photoshop that is contained as a text layer in your image. If you are
working with text that is stored as an image, such as in calendrierdelascience.com,.png or a rasterized text layer, then
any edits that you make to the text will need to be treated as though the text were actually an image.

However, what makes a Once you do that, you should see a cursor. Click and drag on your canvas where you
want your text to appear and draw a bounding box to limit the dimensions of your text. You can then start
typing in your text box. You can alter the dimensions of the text box by clicking and dragging any of the
anchor points. These strategies and font-pairing tools will help you pick the perfect font pairing for any task.
You can also choose the text justification and color. Select the layer of text you want to edit. With the layer
selected, you should see all the same text settings listed above in the properties panel. Here, you can access the
same settings above, as well as a few others. You can change your leading space between lines of text and
kerning space between characters , switch your text to all caps or small caps with the click of a button, and
more. For a simple approach, do the following: Select the Text tool from the Tools panel or by using the
keyboard shortcut T. In the list of layers in your Layers panel, find the text you want to edit and double-click
the large T button. You can then click your cursor in that text to select, delete, or add more text. To move your
text, do the following: Select the Move tool from the Tools panel or use the keyboard shortcut V. Click
directly on the text on your canvas and drag to move without releasing the mouse. How do you use text in
your designs? Let us know your tips and tricks in the comments. Stay informed by joining our newsletter!
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Chapter 6 : How to edit text in AutoCAD | HowTech

The simplest way to edit text in images you're using in PowerPoint is simply to overlay text on or near the image. To do
this, click the "Insert" tab in the menu and then, in the Text area, click.

If a questioned word is spelled correctly, you can confirm its spelling by adding the word to your personal
dictionary. If a questioned word is misspelled, you can correct it. This is the dictionary Photoshop uses to
check spelling. Optional Show or unlock type layers. The Check Spelling command does not check spelling in
hidden or locked layers. Do one of the following: Select a type layer. To check specific text, select the text. To
check a word, place the insertion point in the word. If you selected a type layer and want to check the spelling
of only that layer, deselect Check All Layers. As Photoshop finds unfamiliar words and other possible errors,
click one of the following: Ignore Continues the spelling check without changing the text. Ignore All Ignores
the questioned word during the rest of the spelling check. Change Corrects a misspelling. Make sure that the
correctly spelled word is in the Change To text box and click Change. If the suggested word is not the word
you want, select a different word in the Suggestions text box or enter the correct word in the Change To text
box. Change All Corrects all instances of the misspelling in the document. Make sure the correctly spelled
word is in the Change To text box. Add Stores the unrecognized word in the dictionary, so that subsequent
occurrences are not flagged as misspellings. Find and replace text Do one of the following: Select the layer
containing the text you want to find and replace. Place the insertion point at the beginning of the text you want
to search. Select a nontype layer if you have more than one type layer and you want to search all layers in the
document. In the Layers panel, make sure the type layers you want to search are visible and unlocked. The
Find And Replace Text command does not check spelling in hidden or locked layers. In the Find What box,
type or paste the text you want to find. To change the text, type the new text in the Change To text box. Select
one or more options to refine your search. Search All Layers Searches all layers in a document. This option is
available when a nontype layer is selected in the Layers panel. Forward Searches forward from an insertion
point in the text. Deselect this option to search all the text in a layer, regardless of where the insertion point is
placed. Case Sensitive Searches for a word or words that exactly match the case of the text in the Find What
text box. Click Find Next to begin the search. Click one of the following buttons. Change Replaces the found
text with the revised text. To repeat the search, select Find Next. Change All Searches for and replaces all
occurrences of the found text. Assign a language for text Photoshop uses language dictionaries to check
hyphenation. Language dictionaries are also used to check spelling. Each dictionary contains hundreds of
thousands of words with standard syllable breaks. You can assign a language to an entire document or apply a
language to selected text. Examples of hyphenation for different languages A. Then enter the text. Some type
families include a true expanded font, which is designed with a larger horizontal spread than the plain type
style. Scaling distorts the type, so it is generally preferable to use a font that is designed as condensed or
expanded, if one is available. Select the characters or type objects you want to change. Rotate type Do the
following: To rotate type, select the type layer and use any rotate command or the Free Transform command.
For paragraph type, you can also select the bounding box and use a handle to rotate the type manually. Rotated
characters appear upright; unrotated characters appear sideways perpendicular to the type line. Original type
left and type without vertical rotation right Select the vertical type you want to rotate or unrotate. A check
mark indicates that the option is selected. Select the type layer in the Layers panel. Select a type tool, and click
the Text Orientation button in the options bar. Choose Change Text Orientation from the Character panel
menu. Rasterize type layers Some commands and toolsâ€”such as filter effects and painting toolsâ€”are not
available for type layers. You must rasterize the type before applying the command or using the tool.
Rasterizing converts the type layer into a normal layer and makes its contents uneditable as text. Some
warning messages provide an OK button you can click to rasterize the layer.

Chapter 7 : How to edit PDF documents using Photoshop & Illustrator as Acrobat Plugins.
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You can only erase it (perhaps you have a copy of your image without text: you can copy it over the text) and do it again.
Note: some paint programs, like Gimp, have a proprietary format that can keep information on layers and vector masks,
and textual information.

Chapter 8 : How to Replace Text in Adobe Photoshop: 14 Steps (with Pictures)

Determine how much editing you'll need to do. The steps below for Basic Editing applies to those who only need to add
or replace words, and don't need more advanced text editing options.

Chapter 9 : How to Change Text Size or Colors

Next, let's see how to change font properties. Step 4.a. To change the font properties, use the selection tool and select
the text you want to calendrierdelascience.com property bar located below the menu bar now shows the font options.
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